
 
 

 

  

 
 

 

 

 

 
 

 

 

 

 

User Guide CERC 

ADMS 6 
MapInfo Link 

 



Copyright © Cambridge Environmental Research Consultants Limited, 2023 

 

 

ADMS 6 
MapInfo Link 

 

 

User Guide 
 

 

February 2023 
 

 

 

 

 

 
Cambridge Environmental Research Consultants Ltd 

3 King’s Parade 

Cambridge 

CB2 1SJ 

 

Telephone: +44 (0)1223 357773 

Email: help@cerc.co.uk 

Web:  https://www.cerc.co.uk 

https://www.cerc.co.uk/


Page 3 

CONTENTS 
 

 

 

SECTION ONE: GETTING STARTED ........................................................................... 4 

SECTION TWO: AN INTRODUCTION TO MAPINFO .............................................. 5 

2.1 MAPINFO CONCEPTS ..................................................................................................... 5 
2.2 USEFUL MAPINFO CONTROLS ....................................................................................... 5 

2.3 DISPLAYING A MAP IMAGE IN MAPINFO ........................................................................ 5 

SECTION THREE: SETTING UP AN ADMS RUN USING MAPINFO ..................... 9 

3.1 OVERVIEW .................................................................................................................... 9 
3.2 CREATING POINT SOURCES .......................................................................................... 10 
3.3 CREATING JET SOURCES .............................................................................................. 10 
3.4 CREATING LINE SOURCES ............................................................................................ 11 

3.5 CREATING AREA SOURCES .......................................................................................... 11 
3.6 CREATING VOLUME SOURCES ..................................................................................... 11 

3.7 DEFINING AN OUTPUT GRID ......................................................................................... 12 
3.8 ADDING SPECIFIED POINTS .......................................................................................... 12 

SECTION FOUR: DISPLAYING ADMS RESULTS IN MAPINFO .......................... 13 

4.1 PRODUCING CONTOUR PLOTS FROM ADMS RESULTS ................................................. 13 
4.2 CREATING A LEGEND FOR YOUR CONTOUR PLOT ......................................................... 15 

4.3 FURTHER HINTS ON CONTOUR PLOTS .......................................................................... 17 

SECTION FIVE: DISPLAYING MAXIMUM CONCENTRATION VALUES ........ 19 

5.1 IMPORTING ADMS OUTPUT FILES .............................................................................. 19 
5.2 CLIP POINTS BY BOUNDARY ....................................................................................... 20 
5.3 DISPLAY MAXIMUM CONCENTRATION VALUES ......................................................... 21 

 

 



Section One: Getting Started    

 

ADMS 6 MapInfo User Guide Page 4 

 

Section One: Getting Started 
 

 

To use the ADMS 6 MapInfo Link you will need ADMS 6 and MapInfo Professional1.  If 

you have not already done so, you should install them following the instructions provided 

with each product. 
 

To use the ADMS 6 MapInfo link: 

 

i) Launch MapInfo Professional from the Start menu. 

 

ii) From the MapInfo Tools menu choose Run MapBasic Program. 

 

iii) The dialogue box shown below will appear. Browse for the ADMS MapInfo 

extension file ADMS_MI.MBX, which will have been created when you 

installed ADMS 6. By default it will be in the directory 

<install_path>\Support\MapInfo 

 

   
 

You are now ready to use ADMS 6 with MapInfo. 

                                                 
1 Check cerc.co.uk for the full list of supported MapInfo Professional versions. 

https://cerc.co.uk/environmental-software/system-requirements.html#links


Section Two:  Introduction to MapInfo  
 

ADMS 6 MapInfo User Guide Page 5 

 

Section Two: An introduction to MapInfo  
 

 

If you are new to MapInfo, we recommend that you complete the MapInfo tutorial and 

read the introductory chapters in the MapInfo manual. Some useful MapInfo concepts are 

summarised below to get you started.  Note that the screenshots and command names 

given are based on MapInfo Professional version 11.0, earlier or later versions may 

provide different options. 

2.1 MapInfo concepts 

 All data in MapInfo, whether textual or graphic, is organized in tables. Each table 

is a collection of files that constitute either a map file or a database file. 

 MapInfo presents table data on screen in three different formats 

o Map windows present information arranged as maps, allowing you to 

visualize the geographic patterns of your data.  Tables are viewed in 

individual layers in a Map window.  

o Browser windows present information as tabular lists, just as conventional 

databases do. 

o Graph windows present information arranged as graphs, allowing you to 

visualize and make comparisons of the purely numerical patterns. 

2.2 Useful MapInfo controls 

You may like to experiment with a few MapInfo controls. 

 To zoom to a particular area of a map, click the Zoom In tool  and either click 

on a particular point, or click and drag a rectangle. 

 To return to see the whole map, select View Entire Layer from the Map menu, 

and then choose All Layers. 

 To pan a Map window, click on the Grabber tool  and then click and drag to 

show a different portion of the map. 

 To zoom out, click on the Zoom Out button  and click on the map. 

 

2.3 Displaying a map image in MapInfo 

It is often useful to check the positions of your ADMS sources against a map image, such 

as an Ordnance Survey map tile. Before you can do this, you must register the image so 

that it can be shown in a Map window. The advice below has been adapted from the 

MapInfo manual. Please refer to your MapInfo manual for more details. 
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1. Select Open... from the File menu. 

2. Change the file type to Raster Image.  Select your map file and press Open. 

 
 

3. Press the Register button in the resulting dialogue.  The Image Registration 

screen will appear: 
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4. Press the Projection... button, and choose an appropriate projection.  For 

instance, in the UK you will probably select ‘British National Grid’ from the 

‘British Coordinate Systems’ as shown below.  Press OK when you have made 

a selection. 

 
 

5. Now you must provide coordinates for at least four control points on the map 

so that MapInfo can determine the position, scale and rotation of the image. A 

control point is added as follows. Find a point on the image whose coordinates 

you know, such as a prominent landmark or perhaps a corner of the image. 

Click on the point and the dialogue box shown below will appear. Enter the 

coordinates of the point in the Map X and Map Y boxes then click OK.   
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The control point coordinates are listed in the Image Registration dialogue and 

can be edited if they are incorrect.  Click OK when you have finished.  The 

map is then displayed in a map window: 

 

6. Save the registered map image by selecting Save Workspace... from the File 

menu, and selecting the map layer.  This will save your map with the extension 

.wor.  

 

You only have to register a raster image once. Each subsequent time you open the file, it 

can be opened like any other MapInfo workspace. Choose Open... from the File menu and 

select the .wor file created in step 6 above. 
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Section Three: Setting up an ADMS run using 
MapInfo 

3.1 Overview  

Once your map image is registered, you are ready to position sources on the map and set 

up an ADMS run. 

 

You use the ADMS MapInfo extension by choosing options from the ADMS menu or by 

clicking buttons on the toolbar. The toolbar is shown in Figure 1, and the buttons are 

described in Table 1.  

 

 

 
Figure 1  - The ADMS 6 toolbar 

 

Table 1 - Brief description of toolbar buttons in the MapInfo extension for ADMS 6. 

Button Button Name Action 

 Show ADMS Makes the ADMS model interface active 

 
Show Point 

Sources 

Toggles the display of point sources in the current ADMS 

.apl file in a Map window  

 
Show Jet 

Sources 

Toggles the display of jet sources in the current ADMS 

.apl file in a Map window 

 
Show Line 

Sources 

Toggles the display of line sources in the current ADMS 

.apl file in a Map window 

 
Shoe Area 

Sources 

Toggles the display of area sources in the current ADMS 

.apl file in a Map window  

 
Show Volume 

Sources 

Toggles the display of volume sources in the current 

ADMS .apl file in a Map window 

 

Show 

Receptor 

Points 

Toggles the display of receptors in the current ADMS .apl 

file in a Map window  

 
Plot Pollution 

Contours 

Creates a contour plot of concentrations based on ADMS 

output in the Map window 

 Refresh Updates the display 

 
Add Point 

Source 

Adds a new ADMS point source where you click 

 
Add Jet 

Source 

Adds a new ADMS jet source where you click 

 

Add Line 

Source 

Adds a new ADMS line source where you click (click at 

the start of the source, hold the mouse button down and 

then release at the end of the source) 

 
Add Area 

Source 

Adds a new ADMS area source where you click (double-

click to end the area source) 
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Button Button Name Action 

 
Add Volume 

Source 

Adds a new ADMS volume source where you click 

(double-click to end the source) 

 
Add Receptor 

Point 

Locates a new receptor point for generating output 

concentrations 

 
Define Grid 

Area 

Defines an output grid over the rectangle drawn 

 
Import ADMS 

File 
Imports an ADMS output file into MapInfo 

 
Clip Points by 

Boundary 

Clips a point layer according to the boundaries in a polygon 

layer 

 
Display Max 

Values 
Displays the maximum concentration values in a layer 

 

3.2 Creating point sources 

Follow the steps below to create a point source from within MapInfo. 

1. Click on the Show Point Sources button  to display point sources, if you 

have not already done so. 

2. Click the Add Point Source tool.   

3. Click on the map window at the position you want to put your point source.  

4. A new point source is created and displayed in the ADMS Source screen. The 

source coordinates will have been filled in automatically, but you will need to 

enter the other parameters for the source. To add another point source, return to 

MapInfo by clicking on the MapInfo window title bar, and click on a second 

position on the map.   

5. To see the new point source in MapInfo, save the APL file and then click on the 

Refresh button . 

3.3 Creating jet sources 

Jet sources can be created in a very similar way to point sources. 

1. Click on the Show Jet Sources button  to display jet sources, if you have 

not already done so. 

2. Click the Add Jet Source tool.   

3. Click on the map window at the position you want to put your jet source.  

4. A new jet source is created and displayed in the ADMS Source screen. The 

source coordinates will have been filled in automatically, but you will need to 

enter the other parameters for the source. To add another jet source, return to 
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MapInfo by clicking on the MapInfo window title bar, and click on a second 

position on the map.   

5. To see the new jet source in MapInfo, save the APL file and then click on the 

Refresh button . 

3.4 Creating line sources 

Line sources can be created in a similar way to point sources.  

1. Click on the Show Line Sources button  to display line sources, if you have 

not already done so. 

2. Click the Add Line Source tool.   

3. Click on the map at the starting point of your line source, and hold the mouse 

button down.  Move to the end point of the source and then release the mouse 

button.  

4. A new line source is created and displayed in the ADMS Source screen. The 

source coordinates will have been filled in automatically, but you will need to 

enter the other parameters for the source.  

5. To see the new source in MapInfo, save the APL file and then click on the 

Refresh button  

3.5 Creating area sources 

Area sources can be created in a similar way to point sources.  

1. Click on the Show Area Sources button  to display area sources, if you have 

not already done so. 

2. Click the Add Area Source tool .   

3. An area source can have three to fifty vertices.  Click on the map at the position 

of one of the vertices.  Then, moving around the source clockwise or 

anticlockwise, click at the position of the remaining vertices, double-clicking at 

the final vertex.  

4. A new area source is created and displayed in the ADMS Source screen. The 

source coordinates will have been filled in automatically, but you will need to 

enter the other parameters for the source.  

5. To see the new area source in MapInfo, save the APL file and then click on the 

Refresh button  

3.6 Creating volume sources 

Volume sources can be created in a very similar way to area sources.  



Section Three:  Setting up an ADMS run using MapInfo  
 

ADMS 6 MapInfo User Guide Page 12 

 

1. Click on the Show Volume Sources button  to display volume sources, if 

you have not already done so. 

2. Click the Add Volume Source tool .   

3. A volume source can have three to fifty vertices.  Click on the map at the 

position of one of the vertices.  Then, moving around the source clockwise or 

anticlockwise, click at the position of the remaining vertices, double-clicking at 

the final vertex.  

4. A new volume source is created and displayed in the ADMS Source screen. 

The source coordinates will have been filled in automatically, but you will need 

to enter the other parameters for the source.  

5. To see the new volume source in MapInfo, save the APL file and then click on 

the Refresh button . 

3.7 Defining an output grid 

You can use MapInfo to help you define an output grid.  Note that the grid will be defined 

in Cartesian coordinates. Polar output grids must be defined in the ADMS interface as 

described in the manual.  

1. Click on the Define Grid Area button . 

2. Click on the map at one of the corners of the output grid area and hold down the 

mouse button. Now drag the mouse to the opposite corner of the area.  A 

rectangle will appear on the map while you drag the mouse. When the rectangle 

reaches the size you require, release the mouse button.  

3. The ADMS Grids screen will appear with the new output grid coordinates. You 

may correct them by hand if you wish.  

3.8 Adding specified points 

Follow the steps below to define receptors (also known as “specified points”) using 

MapInfo. 

1. Click the Show Receptor Points button  to view the location of existing 

receptors, if you have not already done so. 

2. Click the Add Receptor Point button   

3. Click on the map at the position for the new receptor point. 

4. The ADMS Grids screen appears, showing your new specified point with the 

coordinates of the point at which you clicked. You should provide a name for 

the point. 

5. Save the APL file and then click on the Refresh button  to view the new 

receptor in MapInfo. 
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Section Four: Displaying ADMS results in MapInfo 
 

4.1 Producing contour plots from ADMS results 

Once you have completed the definition of a problem in an APL file and run the model, 

you can create contour plots.  Please note that you must have used gridded output to create 

a contour plot. On the Grids screen the Receptor type option must be either Gridded or 

Both.  

 

Follow the steps below to produce a contour plot. 

1. Press the Plot Pollution Contours button . 

2. The ADMS Contour Plotter screen will appear. Select the data file and dataset 

you wish to plot, and press Plot.  
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3. The screen below will appear, allowing you to specify a file name and the cell 

size for the calculation. Click OK when you have done this. 

 

 MapInfo stores contour plots in .tab files, like all tables.  It is good practice 

to store your .tab files in a directory with your input files and other data.  

Click Browse... and choose a suitable location. 

 You can use the cell size to control how much detail is shown in your 

contour plot. MapInfo calculates a value for each cell in the grid and plots 

the contours accordingly. 

4. After spending a few moments interpolating the data, MapInfo will display a 

contour plot of your results.  An example contour plot is shown below.   
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4.2 Creating a legend for your contour plot 

You may want to create legends for your contour plots. The advice below has been adapted 

from the MapInfo manual. Please consult the online help or your MapInfo manual for 

further details. 

1. Select Create Legend from the MapInfo Map menu.  The Create Legend 

wizard will appear as shown below. 

 

2. If necessary, use the Add and Remove buttons to make sure that the Legend 

Frames group contains only the layers for which you want to create a legend.  

3. Click Next.  Step 2 of the wizard appears as shown below. 

       

4. Provide a title for the legend and click Next.  Step 3 of the wizard appears as 

shown below. 
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5. Click Finish. The legend will be displayed in MapInfo. You may wish to 

choose Tile Windows from the Window menu to view the legend and the 

contour plot together, as shown below 
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4.3 Further hints on contour plots 

As you become more experienced with MapInfo contour plots you may find the following 

hints useful. You may also like to consult the MapInfo user manuals and online 

documentation for more information on the commands involved. 

 

 To temporarily hide a contour plot layer 

1. Click on the MapInfo Layer Control button 

2. Find the layer you wish to hide in the resulting dialogue. Uncheck the tick box 

next to the layer to remove it from view. 

 To remove a contour plot from a map window 

1. Click on the MapInfo Layer Control button  

2. Find the layer you wish to remove in the resulting dialogue and select it. Click 

Remove at the top of the dialogue box. 

 To generate a translucent plot or change the colours used  

MapInfo gives you control over many aspects of the display of your contour plots. 

The steps below are provided simply as an example. Consult the MapInfo 

documentation for more ideas about the display of your plots. 

1. Select Modify Thematic Map from the Map menu. The Modify Thematic 

Map dialogue will appear. 
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2. Click the Styles button.  

 

 You may like to use the Translucency slider so that your background map 

shows through the contours. 

 

 The colours used in the plot are controlled by the inflection method and the 

number of inflection points. You can change the number of colours by 

changing the Number of inflections in the dialogue. You can change the colour 

for a particular value by double-clicking the colour sample in the list under the 

Percentage caption, and selecting a new colour in the resulting dialogue. The 

example below uses translucency and custom colours. 
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Section Five: Displaying Maximum Concentration 
Values 
 

The ADMS Link provides the facility to calculate the maximum concentration values in an 

ADMS output file outside, or inside, a site boundary.  Typically you would run the 

following options in order: import an ADMS output file, following instructions in section 

5.1; delete points from the output of 5.1, following the instructions in section 5.2; and 

finally display the maximum concentration values of the remaining points, following the 

instructions in section 5.3. 

5.1 Importing ADMS Output Files 

 

This step converts an ADMS output file (.glt, .gst, .gtd, .plt, .pst, .ptd) into a point table, 

which can be viewed in MapInfo.  The field values of the points are provided by the 

ADMS output values for that point, and the coordinates. 

1. Click on the Import ADMS File button  and locate the file to import from the 

Select the ADMS output file to import dialogue. 
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2. Select the name and location of the resulting .tab file in the Choose a TAB output 

file dialogue. 

 
3. Click Save 

5.2 Clip Points by Boundary 

 

This step deletes points from a point table, by comparing against a set of polygons in a 

boundary table, e.g. only the points outside a site boundary. 

1. Ensure the point and boundary tables are open in MapInfo. 

2. Click on the Clip Points by Boundary button  to display the Clip Points by 

Boundary dialogue. 

 
3. Select the layer containing the constraining polygons from the Boundary Layer 

drop-down. 

4. Select the layer containing the ADMS point data from the Point Layer drop-down. 

5. Choose whether to keep only the points within the boundaries, or only the points 

outside the boundaries. 
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4. Click OK  

5.3 Display Maximum Concentration Values 

 

This step reports on the maximum value for each field in a point table. 

1. Click on the Display Max Values button  to display the Display Max Values 

dialogue. 

 
2. Select the point layer in the drop-down and click OK to open a new browser 

window containing the maximum values of each concentration recorded in the file.  

The information in the browser is also automatically copied, ready to paste into 

another program, e.g. Microsoft Word.  

 

3. Click a row’s selection checkbox to highlight that row’s maximum value point on 

the map.  


